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Generation of Database and Implementation of
Web Enabled Water Resources Information System in
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Water Resources Scenario - INDIA

2.45% of World’s
Land Area Total Precipitation (rainfall + snowfall)

4% of World’s 4000 BCM
Renewable Water v
Resources

17% of World’s

Total water availability

Population 1869 BCM

Water Availability — v

1545 Total utilizable water resources
cum/person/year 1123 BCM (28%o)

Scarcity - 1000

Ground Water
433 BCM

Surface water
090 BEI\

Current utilization
of GW
245 BCM (62%0)

Current utilization

Presently meets the demand but is Inadequate for
future demand




Spatial Variation of Rainfall in INDIA

/5% During Monsoon

No of rainy Days — 5 to 150

Most rains in 15 days in 100 hrs

Rainfall in mm

Average | 1,170

Max. 11,000 Mawsynram
Meghalaya
Min. 100 Western

Rajasthan




Major Achievements in water Sector

Total Large Dams- 5193 (4846+347)
Total Storage — 304.3 BCM (253.38+50.95) LR g ¥
Net Sown Area — 142 M ha

 Ultimate Irrigation Potential — 140 M ha
* Irrigation Potential Developed — 112.3 M ha (80%)

Highest Area Under Irrigation in the World — 62 M ha
Food Grain Production — 257 Million Tonne

Total Identified HE Potential — 1,48,701 MW

Total Installed Capacity — 36,013 MW




National Water Policy (2002 & 2012)

Water resources development and management will have to be planned for
a hydrological unit.

A standardized national information system should be established with network of
data bank and databases, integrating and strengthening the existing central and
state agencies and imp[roving the quality of data and p

All hydrological data, other than those classified on national security should be in
public domain

Water related data, like rainfall, snowfall, geo-morphological, climatic, geological,
surface water, ground water, water quality, ecological, water extraction and use,
irrigated area should be integrated with well defined procedures and formats to
ensure online updation and transfer of data to facilitate development of database
for informed decision making in the management of water resources.

National Water Mission For Climate Change

Comprehensive water data base in public domain and assessment of
the impact of climate change on water resources




Provision in Inter-State River Water Dispute Act - 1956

Maintenance of Data Bank and Information

1) The Central Government shall maintain a data bank and
information system  at the national level for each river basin
which shall include data regarding water resources, land,
agriculture, and matters relating thereto, as the Central
Government may prescribe from time to time. The State
Government shall supply the data to the Central Government or to
an agency appointed by the Central Government for the purpose,
as and when required.

2) The Central Government shall have powers to verify the data
supplied by the State Government, and appoint any person or
persons for the purpose and take such measures as it may consider
necessary. The person or persons so appointed shall have the
powers to summon such records and information from the
concerned State Government as are considered necessary to
discharge their functions under this section.

CWC has been notified to maintain database



India-WRIS - Background

In the year 2006
Secretary, Water Resources (Dr Harinarayan) stressed the need to
generate total
Information on all aspects of water resources at national level at one
place in an integrated fashion for use across Ministry of Water
Resources (MoWR) offices and also
for other stake holders.

« After several round of discussions between CWC & NRSC for two
years the proposal was finalised in 2008

« MOU signed in December 2008

« January 2009 — December 2012 (extended upto December 2015)



Objectives

e To collect available data from varied sources, generate new database, organize
in standardized GIS format and provide scalable web-enabled information
system.

e To provide easier and faster access for sharing of nationally consistent water
resources data through a centralized database server.

e To provide tools to create value added maps by way of multi-layer stacking so
as to provide integrated view to the water resources.

e To provide foundation for advanced modeling and future Spatial Decision
Support Systems (SDSS) & automated data collection system.



Datasets (Spatial and non-Spatial) Required for Planning
Water Resources Project

Water Resources Projects are Complex in Nature &
Multidisciplinary

« General Planning — Administrative information, Terrain Data

« Structure Design (Dam & canal, Power House) — Geology, Soill,
Material, Seismic

« Water & Irrigation Planning — Meteorological data, Hydrology data
(River flow, Sediment, Water Quality)

« Reservoir Planning — Demographic data, Contour data, Different kind
of land data including Forest, Ecological data, Economic data

« Canal and Command - Land data, Demographic data, Ground water,
Agriculture data, Soil data, Economic data



SCOPE OF PROJECT

/

¢ Based on the requirements and data
availability, the project scope has
5 major groups of datasets having
30 spatial layers with

more than 95 sub layers of

5-100 years data

and Basin-Wise report generation.

«¢» All the new database creation under
India-WRIS is proposed at 1:50,000 scale.

/

¢ The project envisages
WGS-84 datum and LCC projection
for entire country mosaic data.




India-WRIS - Database 1

S. Major groups of Spatial Layers and details
No. |database

1.1 Basin maps — Basin, sub-basin,

1. Watershed atlas catchment, Watershed
1.2 River network
1.3 Digital Elevation Map
5 | Administrative 2.1 International, State, District, Tehsil
layers

2.2 Village boundaries
2.3 Town / Villages location and extent

2.4 Infrastructure layers
2.5 Major Tourist Stations sanctuaries,
Waterfalls & other issues

Water resources 3.1

projects Location of Major & Medium

3.2 Location of Hydroelectric projects

3.3 Location of Multipurpose projects

3.4 Major and medium Irrigation project
command boundaries

3.5 Water logging and salt affected areas in
major, medium projects




India-WRIS - Database 2

3.6 Soil samples for major, medium
irrigation projects

3.7 Canal network

4. Thematic layers 4.1 Surface water bodies

4.2 Ground water observation wells data
analysis

4.3 Litholog data with aquifer parameters

4.4 Land use /land cover

4.5 Land degradation

4.6 Wasteland maps

4.7 Snow cover area

4.8 Flood inundation maps

4.9 Drought Prone Area Maps

4.10 Inland navigation waterways

4.11 Inter-basin transfer Links (As per
NWDA Proposal)

Environmental

data 5.1 Hydro-meteorological sites of CWC
5.2 Meteorological station (IMD, CWC)
2.3 Climate related layers

5.4 Pollution Monitoring Stations

6. Report Basin-wise report generation




SOURCES OF VARIOUS DATABASE

Minor Irrigation

WISDOM/SWDES P—————
(G&D data)
_| CWC projects (AIBP mapping,
¢ GIS LAYER (30) Snow cover mapping)
Data of Water Resources | \ 1o gg pevVELOPED BY ISRO
Project <
o RIS Real Time (FF data,
Water level data -CWC,
Reservoir data)
Data from
DRIP,
Hydrology Design AID, Data of Water Resources Data from PC, MOWR,
HP-II Project Tribal affairs, CGWB, NWDA,
Project from State Governments IMD,SOI,IWWS,NRSC(Satellite
and legacy data)




PRESENT STATUS

Total 4 version uploaded

Present version has 95 GIS layer with 700 attribute and 5 to 100
year time series data

CWC H.O. un-classified data uploaded which can be freely
downloaded

CGWB 15 years data in the form of graphs uploaded

CWC telemetry network connected and real time information
available

River Basin Atlas of India

Basin reports & Watershed Atlas uploaded



Milestones - India-WRIS

Version
4.0

Launched

In March

Further

updations

done in
December

2014
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India-WRIS Atlas Release — Nov 1, 2012 Version 3.0 Launch Dec. 4, 2012




Front GUI of Information system

- About WRIS - Accessibility > Tools : Metadata > WRIS Wiki [Searcn )
£ 2.

lndla-WRlS WebGIS

Water Resources Information System of India
* Publications * Gallery * Mobile * FAQ * Feedback Sign In/ Register

Ui {ISPrQ

India-WRIS A AT 8

Geo-Visualization

Sub-Info System The project “Generation of Database and Implementation of Web Enabled Water ©

Temporal Analyst Resources Information System in the Country” short named as India-WRIS

New Watershed Info System WebGIS is a joint venture of the Central Water Commission (CWC), Ministry of
Water Resources, Govt. of India and Indian Space Research Organization (ISRO),

m Department of Space, Govt. of India, as per the Memorandum of Understanding
Live Telemetry Data (MOU) signed on December 3, 2008 between the two departments for a period of News And Events

ELUTLT four years - January 2009 to December 2012.
New Resenvoir Module

New Automatic Map Generation New Basin Reports available for

India-WRIS WebGIS aims as a ‘Single Window’ solution for comprehensive,

; A s e & i download
NewAdvanced Report Generation authoritative and consistent data & information of India’s water resources along
with allied natural resources in a standardized national GIS framework (WGS-84 New Watershed Atlas of india
Share Success Stol
ry datum and LCC projection) tools to search, access, visualize, understand and . . i _—
= PR ¢ : New MNon-Classified HO data available for
WR Planning & Management analyze the data for assessment, monitoring, planning, development and finally A

Croats Your WRIS Integrated Water Resources Management (IWRM).

2D-3D Linked View
Collaborative Planning

Input Data Builder

Spatial Data
Non-Spatial Data
Metadata

@& River Basin Atlas of India has been
The data collection, generation and presentation into the portal are continuous launched on November 1, 2012,

activities. The current version India-WRIS WebGIS (Version 4.0) has spatial
layers and attributes as per data collected till April 2013. Further updating the @
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Modules/Sub Modules of the Information System

WRIS Info Discovery

> Data Catalog

WRIS Explorer

> 2D Geo-visualization
> Sub Info Systems

» Temporal Analyst

> Watershed info system

> Live Telemetry Data

> Data Download

> Reservoir Module

» Automatic Map Generation
» Advance Report Generation

Share Success Story

Water Resources Planning

% > Create Your WRIS

» 2D-3D Linked View
> Collaborative Planning

Input Data Builder

WRIS Info Discovery & Data Catalog module
provides the details about the layers and data
availability along with metadata information based
on area of interest

WRIS-Explorer module has Interactive system for
Geo-visualization, exploring various sub-info systems
and analyzing the temporal data & Watershed info
system as well as watershed report based on basin
and administrative unit

WRIS Connect contains module: Data Download
module, CWC Live telemetry data, CWC monitored
Reservoir data, Map and Report generation as per
area selection

Share Success Story module to share/view various
water related success stories over the globe

Water Resources Planning It allow user to create
your maps, 2D to 3D visualization with Google earth
and sharing information among users in
participatory mode like text file, maps, videos etc
Input Data Builder module allows privileged users
to add or update the spatial, non-spatial data and
metadata information



Main Information System — 12 Sub System — 35,

Layers - 95 and Attributes - > 700

1. Base Data Info Systems

1. Administrative 3. Infrastructure
2. Region 4. Terrain

2. Surface Water Info Systems
5. Water Resource 9. Surface Water Body

Division 10. Water Resources Projects
6. Basin 11. Command Area
7.  Watershed 12. Minor Irrigation
8. River 13. Canal

3. Ground Water Info Systems

14. Aquifer / Litholog
15. Ground Water Level
16. Ground Water Potential (RGDWM)

4. Hydro - Met Info Systems

19. Hydro -
Observation
20. Flood Forecasting

17. Meteorological
18. Climate

5. Water Quality Info Systems

21. Surface Water Quality
22. Ground Water Quality

6. Snow Cover / Glacier Info Systems

23. Snow Cover / Glacier

7. Inland Navigation Waterways Info
Systems

24. Inland Navigation Waterways

8. Inter - Basin Transfer Links Info Systems

25. Inter - Basin Transfer Links

9. Hydro - Met Extremes

26. Flood
27. Drought
28. Extremes Events

10. Land Resources Info Systems

29. Land Use/Land Cover 31. Wasteland
30. Land Degradation 32. Soil

11. Water Tourism Info Systems
33. Water Tourism

12. Socio Economic Info Systems

34. Rural
35. Urban




Tools and Functionalities

Qldemify
. . %«Swipe
Navigation Tools Drones
O Zoom In: It zoom into a particular area on map selected 7

by the user.

{) _
{ Magnifier

k?:alﬁel Feature Info

@&Zoom Out: Is zooms-out the map to come out of the detailing..

} Pan: It allows user to Pan around the whole map

e Full Extent: It allows viewing the map at the full extent..

Previous Extent: It allows going to previous extent when the map extent is changed.

» & Next Extent: It allows returning from the previous extent.

Map Overview: Provides location of current view in context with larger map area.

&7 Go To: Zoom to an area based on specified latitude and longitude

Doede

Select Area Zoom/Rubber Zoom: Smooth Zooming into a selected area

Display Tools

— Swipe: It swipe the selected layer in the map to reveal underlying layers.

O)ﬁ Spotlight: It removes overlaid layer from the selected portion for better visualization
/—) Magnifier: To view the zoom in layer details of selected portion only

Get Feature Info: On selecting a particular feature it displays summary info

o Identify: Identify the details of all the visible layers including the elevation details of the point




Tools and Functionalities

Personalization Tools

% Print: To print the current viewing area in landscape or portrait mode.

EI Save as Image

'3 Bookmark: Allows book marking a specific location on the map for future reference.

%\ Pin Mark: User can pin mark his location of interest and type his comment on same

Sharing Tools

@ Share a Link: Share the current view of map with another user through mail.

\&@ iFrame: Sharing frame of India-WRIS in other applications.

orEux

a0 Links on twitter/Facebook/Google+

Advanced Tools

. Surface Profile: Generate the surface terrain height graph of selected points on map.
L
b Network Analysis/Route Tool: It specifies the defined route of road, rail and river network.

%" Geo-Calculator: Tools to calculate parameters based on location and user input.

Linked View: Can View multiple view of different information in a single window.

Search & Query Tools
@ Query Builder: create user defined queries
O Search by Proximity




eo-Visualization (Surface profile tool)

' | 71 India-WRIS Version 4.0 x Y | ) India WRIS Geo-Visualizatior %
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+, Water Resources Information System of India

WRIS Explorer ) GeoVisualization [SubinfoSystem  |Temporal Analyst

=¥ Visualization Layers

India-WRIS Data Set

» (V1|8 DEM

» [V][B watershed Atlas

» V] [B8 River

» (V][ surface waterbody

>V Administrative

» [@] B8 infrastructure

» (@] [ commana Area

» [8] [ water Resource Projects
» [@] B8 Forest Cover

» ] wLc

» 1B waterLevel Layer

» (@] B8 meteorological Station

» (@] [B Hydrological Observation
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Major Digitization Work

« Source: Merged Product of Cartosat — | & LISS-1V data & SOI, SRTM

e Scale: 1:50K

Basin/Sub-Basin/Watershed — 27/101/4566
River — 36 lakh km

Water bodies (upto 0.5 ha) — 8 lakh

Road Network (Upto village) — 27.0 lakh km

Settlement Location & Extent — 9 lakh/8.9 lakh ( 77,798 sq
km)

Canal network — 3.20 lakh km




Watershed Delineation in India

* All India Soils and Landuse Survey (AISLUS)
atlas at 1:1 M scale (35 Basins)

« CGWB basin map 1: 250,000 (34 Basins)

« CWC basin map — 20 Basins

* NCIWRD - 25 Basins



NEW Digital Watershed atlas

Hydrological Digits  Range
Levels

1 Region
g VL ; _ 2 Basin 02 1-25
% ¥ 3 | Sub Basin 03 | XYz
: R*’BASIN ATLAS 4 Watersheds 02 [1-99
I\ﬁ)i A 5 | SubWatersheds | 03 h :-gg
U 1-99
6 Micro Watersheds | 02 1-99

Mahanadi Basin

Central Water Commi s
Ministry of Water Resources + .
Sewa Bhawan, RK. Puram -

99 L99 99




Water Resources Region

' |} India-WRIS Version 4.0

X /Y [ India-WRIS Water Resource: X ( |} India-WRIS Watershed Sub | X A\ & Main Page -

€« C' [ indig-wris.nrsc.gov.in/WRRApp htm|?2UType =R
> About WRIS

» Accessibility

fUZXIhbA==7UName=

lndIH-WRIS WebGIS

Water Resources Information System of India

HOME )) WRIS Explorer )) GeoVisualization | SublnfoSystem ) Water Resources Divisons |Temporal Analyst

India-WRIS Data Set
> V[ pEM
» VB wrD
» V][ River

» V][ surface Waterbody

her Basin/Country

» Tools = Metadata

)

Island ‘airiage
k -

k]

.t_,

Summary

No. of Water Resource Division(WRD): 3
No. of Water Resource Region(WRR): 6

Water Resource Division

Water Resource Region

India-WRIS Water Resource Regions

Region Name

Total Area(Sq.Km)

92°41'24.76"E, 17° 16'59.76"N

Indus Drainage

Rivers Draining into
Arabian Sea

Minor River Draining
into other
Basin/Country

Brahmaputra Drainage

Rivers Draining into
Bay of Bengal

Island Drainage

552,085.40
521,693.74

59,469.03

540,640.46

2,085,210.77

7,752.18







River Network

' [} India-#RIS Yersion 4.0 xy [} Indig-WRIS River Sub Info = % W | P=R e

<« C' [1 indigrwrris nrsc.gov.in/River App il U Type =R 2vuZ JhbA ==7_Name =
» AboutWRIS = Accessibility > Tools - Metadata > WRISWiki = Help

Ind'a'WRIS WebGIS

Water Resources Information System of India

2
n

HDME»WRIS Explorer D GeoVisualization | SubinfoSystem » Ri\fer|Tem poral Analyst

Get River Details

India-WRIS Data Set J? 4 N ' i Search River by Name
» [ ][ DEM o :

» [@] [ Administrativ

» V][ River

List of rivers based on:

Ol ssestasae -] @
Ol setestapistit. |- @
Ol setectagasin |-/ @l
Ol selectasuee.. |-/ @l

Clear




Different Components of Water Resources Project

<

16/01/2006 iR Hathnikund Barrage -

e SeS



DATA-STRUCTURE FOR WATER RESOURCES

Single State/

Interstate

>

PROJECT

N

WR Complex/System

A

(Irrigation/HE/Multipurpose)

Multi Purpose Project

<

Irrigation Project (Major/Medium/Minor)

HE Project (Major/Small/Mini/Micro)

/'

Dams

»

“|IReservoir

\

P
<

e

Single State/Interstate

Barrage/Weir Lifts

Canal Network (Main, Branch,

A

A 4

Distributary, Minors)

A 4

(Left Bank/Right bank)

Command Area

/

Irrigation/Irrigation cum Power/Power Canal




WATER RESOURCES PROJECT

» About WRIS = Accessibility = Tools = Metadata = WRIS Wiki = Help

|nd|8-WR|S WebGIS

Water Resources Information System of India

» ][ Infrastructure

Number of Lifts - 352

Canal Network —3.2 lakh km

Hydro Power Stations — 293

Water-bodies- 8.0 lakh

500 km

400 mi i nap
A EEEEEE—S——————— o ]

—
14 start | iG] |List of defectsin WRI... | Bl WARIS Presentation ... | G WARIS_Presentation... | ‘2 MainPage--Mirosa.. ) India-WRIS Water Re... ¢ BEE 2 1207




Water-Bodies

» About WRIS  » Accessibility > Tools > Metadata > WRISWiki * Help

lnd'a-WRIS WebGIS

Water Resources Information System of India

HOME Y WRIS Explarer ) Geovisualization [SublnfoSystem ) Surface Waterbody (Temporal Analyst

Waterbodies Information System | W Information System ( Identify Waterbodies

India-WRIS Data Set Water Bodies Search | Water Bodies Results
> V][ DEM
» [V] [ waterBodies

Size! Type wise Search
Size (Ha): (AII
Type: (al

» [8] ¥ wetLands

> BB
> V][ Administrative

Name: Watert ,

Minimum 3 letters

Total around 8.0 lakh = i poorilk ¥y Sear,
water bodies - sl R

Basin: (select Basin [

Sub Basin: (gelect Sub Basin [»

State/ District wise Search

State: (gelect State [»

District.  (gelect District [




Maps/Information Received from State Government

z for L
s £ o= 3
E S 4
3 s
] i
B Fr 3

Y S i
M PRCTECT f
¢ ] ( L P
B MU Pef3n/N J
o e
) ik
SN

Ot 5
{ 3
\ ¢ R 2
l 2
£



Mapping of Irrigation Infrastructure using

Cartosat Data

Fig : 5 - Map showing Satellite derived Irrigation Infrastructure
of Chandrabhaga Medium Irrigation Project, Maharashtra
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WATER RESOURCES PROJECT & COMMAND

’ [ India-WRIS Version 4.0 *® y [ India-WRIS Water Resource |
<« c D |r1d|a wris.nrsc.gov. in/WRPApD . Htm U Type =R 2VUZX Ihba =="UName = e =
" » About WRIS = Accessibility = Tools = Metadata - WRISWiki = Help

Indla-WRIS WebGIS

Water Resources Information System of India

HOME 3} WRIS Explorer }} GeoVisualization | SubinfoSystem ) Water Resource Projects | temporal Analyst

Get Details Sedimentation Studies Download Report WRP Linkages

India-WRIS Data Set

» [V] [ sdministrative Nilanjgaon Damy

h Nilagfaaon
» V][ Canal & Related Laye . !
!

i

u M N
» [V] [ Watershed Atlas b Georai Damnebgaon D‘ailm

v [ River o e i Name-wise Search:

V] [ surface Waterbody - 3 Aurangabad A b . Hame Type

i bnatour u—__KiyA\gann
¥ [ sedimentation Inay atpur DamKanadghon Datdna _ Jayakwadi Stage - | Major Irrigation Project
Dawarvadi Da Irrigation Project

=] [ wrp L . Bramhagavan leﬂon Part-1/

|
i
1/ Infrastructure <3 oy re i

Jayakwadi Stage - Il Major Irrigation Project

Related Structures Salient Features

@2

Jayakwadi Stage - | Major Irrig 4 | Attribute Name | Value

Maharashtes . P 3 Ccommand Area ( JAAK)
~—Dam { Jayakwadi-lDam ) ||
) Structure Purpose (
= ! £ Structure Purpose (
+—Powerhouse ( Paithan F
Reservoir { Nath Sag.
+—Multipurpose Project ( Jawy
— | CADA { Jayakawadi Proj
—_1 Project Eng Type { JIO04
Jpatrardi “®  Shindewadi (G) Da L[| Potential ( JID0472)
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B || Potential { JI00472 )
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Mohari Pathardi Dam 1 Kbjdid nia L | State ( JIOD472)
il | | Project Purpose ( JIOD4
[ | Cost{JI00472)
[ ] Cost(JI00472)
[ | Cost{JI00472)

-

Basin Godavari

Crest Level of 455 95

Shevemon

Cesign Flood 22656
District Aurangabad
Ahmiadnagar
Length of dam 10415
Length of 417
Goviflvadi Max. height 41.3

Mame of the Jayakwadi-l Dam
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» About WRIS  » Accessibility > Tools  » Metadata > WRIS Wiki > Help

|nd iF]-WR |S WebGIS

Water Resources Information System of India

HOME ) \RIS Explarer ) Geovisualization| SublnfoSystem ) Canal| Temparal Analyst

_ -

India-WRIS Data Set

State wise Basin wise

* Regulator (Head f Cross) kol ? /Lg 5.Mo. | State Mame | Canal Length (
X |
+  DBridge s d 1 Andhra Prade| 39521.01
2 Bihar 1852305
Aqueduct/ Syphon Agueduc
3 Chhattisgarh | 13379.32
+*  SuperPassage ! Syphon o 4 Delhi 18924
Level crossing f Inlets & outl 5 Dadara & Ma| 37.28
«  Other Cross Drainage Struc B Gog 221.45
(-] .
+  Ofitake Point 7 Gujarat 11376.29
g Himachal Pre| 25.42
» V][ Canal
9 Haryana 15420.21

¥ [ Command Areas

-
[==]

Jharkhand 2884.35

|:| Major Cammand -

. Mediur Gormimand Il

11 Jammu & Ka| 2479.89

X ‘:” rKI/N-DIJIﬁ. j{}{{

12 Karnataka 2982393

» (@] [ Administrative 13 | Kerala 3375.82

4]

14 Madhya Prad| 1495435

18 Maharashtra | 30508.74

Query By Shape
16 Cdisha 14141.80
Administrative Unit 17 Punjab 12764 493
@ | Select a State |v || Go | 18 Puducherry | 24.05
18 Fajasth 42507.90
@| Select a District [+|[ &0 | CIEIET

20 Tamil Nadu | B569.92

B

Hydrological Unit 21 Uttarakhand | 1866.08

@| Select a Basin [=|[ o | 22 | Uttar Pradest| 59215.13
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CWC H.O. Network
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Activity HOIFF
Station Type (Current) G030 Musto Type B.M Value(m) 305.525
TehsilTaluk Hoshangabad Type of Bed Sandy
District Hoshangabad River Width(m) 765
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Meteorological Network
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TEMPORAL ANALYST
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CWC Monitored Reservoir Module
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CWC Telemetry Network

» About WRIS > Tools » Metadata > WRIS Wiki » Help

» Accessibility

|ndla-WR|S WebGIS ;
&

Water Resources Information System of India \

Legend
Select station from left menu or

'E‘ Mon Classified Sites

E‘ Classified Sites

Search by name

"State Wise Selection
Select State::

SelectA State

Classified Telemetry Sites::

Non-Classified Tel try Sites::

"Basin Wise Selection
Telemetry Site Selection

Disclaimer:

The Telemetry data available on this page
are provisional data that have not been
reviewed and edited. These data may he
suhjectto significant change and are not
citeable.

1000 km
1 ]

|
500 mi

click on the map to get details

YAGI satellite
antenna

r-

TUBING
1

SITE OFFICE

Data Collection
Platform (DCP)

Direct Digital Readout
Ground Station (DDRGS)
At Jaipur and Burla

L]

MODELLING CENTERS

Water Level Chart




CGWB Ground Water Well Network

» About WRIS » Accessibility > Tools » Metadata

Indla-WRlS WebGIS

Water Resources Information System of India

> WRIS Wiki

HOME ) \WRIS Explorer ), GeaVisualization| SublnfoSystem ) Ground Water Level| Temporal analyst

i ( Get Detailsj (Water Level Maps)

» Help

India-WRIS Data Set
» V][ DEM
> V][4 watershedAtias

» [V] S Administrative

> V][4 Gw Level

Graphical view of Water level Data

©| Select a State v Go
Q| Select a District v Go
©| Select a Basin > Go
Ol Selecta SubBasin hd Go
() Click to draw area on map Go

[ Clear )

1000 km
1 ]

1
500 mi

Static Parameters of Wel




CONTINUED

€ - C | [) www.india-wris.nrsc.gov.in/GWLevelApp.htm|?UType=R2VuZXJhbA==?UName= w s =
About WP Accessih 00 etadata R elp Search
08
adia
W o

| | Seasonal | Fiuctuation &L s y "“'\‘H\'.'\n{ X
:)WRISeasonWater Level 1008 |+] | Pre Monsoon || i 0 \Q/ [ N

w

India-WRIS Data Set

» V][ DEM

> [V [ Watershed Atlas = _

Static Parameters of Wells

o

Attribute Nam| Value

Depth (m)

> [V] [ Administrative

> V][ GW Level = -

Hura Bagds 20 Kenda-2 Ludurka Keshargarh Simla2 Bishpuria
SITE NAME

INDIA

Click to draw area
® onmap

( clear )

! ( Miewin TemporalAnalyst-)

> UL Move mouse on map Source:CGWB,Faridabad




’ [ India-WRIS Version 40 W [1) India WRIS Temporal Az x Y\ RS

& = € | [ www.india-wris.nrsc.gov.in/TemporalAnalystApp.html?UType=R2VuZXJhbA==?UName= w M =
Fi » AboutWRIS  » Accessibility  » Tools  » Metadata  * WRISWiki Help

HOME ) WRIS Explorer
. Temporal Analyst

e N

[ Seasonal Water Level Graph ]l Comparison of Water Level Graph | Yearly Water Level Graph

Start Year End Year
West Bengal EEEE i veme|avcul Select from Ma Create Graph
utlapur electirom p 2012 reale Grap

GV Level-Post Monsoon Kharif i _ 5]
Post Monsoon Rabi Water L
2 _

Depth (m)

2004 2005 20068 2007 2008 2009 2010 2011 2012
Year

. i PM 03:47
8 « [ L
P @ o € s



CONTINUED

Ia- ersion ® ndia-W around Water %
India-WRIS Version 4.0 India-WRIS G dW :‘

&« C' [ www.india-wris.nrsc.gov.in/GWLevel App.html?UType=R2VuZXJhbA==7UName= g & =

» About WRIS

India-WRIS w.

Water Resources Information Syster

'WE ) WRIS Explorer ), GeoVisualization| SubinfoSystem ) Ground Water Level e

*

+ Accessibility

&

+ Tools + Metadata = WRIS Wiki + Help

Ground Water Level (WL) Maps

| - | [ West Bengal

Pre Monsoon WL 2006 Post Monsoon WL 2006

(et tails) ( Water Level Maps )

India-WRIS Data Set

» V][ DEM

» (V][ watershed Atlas

» ][ Administrative
> V][ oW Level

Graphical view of Water level ...

Click to draw area

[[] Show Legend & [[] show Legend &

100 km ] 200 km
— West Bengal
50 mi £ E 100 mi

o

Mots: This map is prapared from available Ground Water Level dats of CEWE using
inverse distance weightad interpolation technigus

Maote: This map is prepared from available Ground Water Level data of CG
inverss distance weightsd interpolation technigus

WL Fluctuation due to recharge 2006

WL Fluctuation due to draft 2006

O ~ 1000]km}
onmap 5
Fs ~ t
Clear mi
- . *
/

® € & [N

[[] Show Legend & [[] show Legend &

-

Wesg Bengal,

200 km 100 km
100 mi 50 mi

Mote: This map is prepared from available Ground Water Level dats of CGWE using
inverse distance weightad interpolation technigus

Maote: This map is prepared from available Ground Water Level data of CG
inverss distance weightsd interpolation technigus

- W= W)
P il o g oms



Town & Village Location & Extent

' | India-WRIS Yersion 4.0 X Y India-WRIS Infrastructure 5 X v 1 India-WRIS Socio-Economic(l X

€« (&

[ india-wris.nrsc.gov.in/Rural;

India-WRIS webe

IS

Water Resources Information System of India

HOME ) WRIS Explorer ) GeoVisualization| SubinfoSystem ) Rural| Temporal Analyst

[ | [ village Boundary | ( Get Details )
India-WRIS Data Set ‘Fashik e : e
] 7
> [ DEM i 5
3 3 ey
» [B] % common Layers 5 e Bu'dana
I}.Deulpon Raja-urban
-
» [V] [ Rural Settlement rba - S R e s % Ny Swdkned Raja-urban
> [#] [ Urban Settlement 3 g‘Aumn‘gahd'(ng‘n)' : - “z\\ ‘,_r/\ g
fugpeebl ot . G
. B =
[ 3 L 2 42&*
; ®
.Ga ngapurfurban) ‘.‘
Total — lakh : :
Ota 8-90 a Bt T _Goda"e‘ri L'p',?v 'J—" 3 Jeinu -
B, % g JAmEad oL S
JNeas Khgurail == s @amini 5
- ‘¢ % £ A . =
Jie Ty i S
{73 _Paithan (urba :
: il i (urr‘,crféxmﬁa.h piddle f <
B ! | . L& =5 s
e dsana par g e i Goaavar Basin s ey o
‘ sheigharasitra_ . ¢ = 4 ¢
o> Hevgson s (oo F 025"y 3 ; g
+ Ahmadnagar 2 i <
> : Ry ek Ll e o v ; !
Query By Shape ; Gl ('“’al‘)Gec_iraiUrban 2 SR 3 ¢ Parbnant PARBHANI \T_} 2 e J
L e Lo

Administrative Unit

o

Hydrological Unit Bhima Uppiei
L Keishie BASH
ct a Basin v Go @ i3
5 - g o
ct a SubBasin v Go . &2 :f
I 3

¥

rar
FEORS

= Gsmanabad ™o~
b

-

Manjlegaon.(rumwa"]hﬁf-'" Urban

Microsoft PowerPaint ...

/RIS Socio-Eco...




Road Network
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Major Challenges Faced

* Defining Data Structure for Water
resources Project being Complex In
nature

 Collection of Water Resources
Project Data from State Government
and conversion into GEO-Database



Where are we now

» Water Resources Information System to Spatial Decision Support
System for IWRM has three stages:

1. Pulling the entire database and designing a common
framework of water resources data along with ancillary data
to be used by all stakeholders for water related issues.

2. Detailed studies are carried out on watershed, river basin or
state level using detailed data, customized application
studies and applying models for problem solutions.

3. Involve automation in the entire process for data collection
& organization and accordingly real or near real time analysis
and forecasting.

» India-WRIS WebGIS Project jointly executed by CWC & NRSC,
ISRO has accomplished the first stage to a large extent. The
second and the third stages are to be accomplished by proposed
National Water Informatics Centre alongwith stakeholders.



National Water Informatics
Center



Goal of NWIC

To generate, organize and provide up to date data
and Iinformation on water resources and allied
themes In public domain; and develop value
added products and services for integrated water
resources management.

Centre will be manned by Water domain expertise, Geo-Informatics &
IT/Systems domain (Role of CWC & CGWB will be extremely important
alongwith other stakeholders)



Conceptual framework of the linkages

 The center will have professional linkages with central government departments, state
government water resources departments, regional CWC offices and linkages with the portals
having water resources related data/information. Conceptual framework of the linkages is
described in figure below.
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Major Focus Area of NWIC (Next 5 years)

Creation of Nodes /linkages in states & Institutions - Regular
updation and addition of new database

Real time data (Reservoir, River, Water quality, meteorology,
Ground water, flood, soil moisture) - Linkage through RTDAS/SMS
based (DWRIS & HP-III)

Integration/linkages with modules — PMP Atlas, HDA, e-SWIS, e-
GEMS, DSS (P)

Mapping/Monitoring (Using sub meter satellite data) - CADA
works, RRR Scheme, AIBP, Flood protection, Glacial lakes &
Development of MIS, Coastal Management Information System

Emergency Response during Floods to CWC & State authorities
(Flood inundation mapping) , Estimation of Flood using QPF (With
IMD help)

Generation of dataon 1:10K & 1:4 K



« Software — Web map & Web feature services, Mobile App, Crowd Sourcing
(For floods, water quality and water bodies etc), Improve user friendliness,
MultilingualL, WRIS Education

 Application/Studies with the help of domain expertise (Irrigated and un-
Irrigated area, crop mapping in MMI command vis-a-vis originally planned,
Sedimentation Index, Watershed prioritization for major reservoirs, Water
Quality status of India, Virtual water trade amongst states etc)

 Bringing out State of the Art report ( State-wise & Basin Wise
Irrigation/Water Resources Development , Water stress Area Atlas etc)

* Input — Re-Assessment of Basin-wise water resources potential studies,
Morphological studies, e-water

« Awareness Programme

 Publication- Irrigation Atlas of India
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